
 

 
 
 

Knowledge-Based Compilations and Reviews is designed to help the accountant efficiently and effectively perform financial 
statement compilations and reviews of nonpublic commercial entities in accordance with Statements on Standards for Accounting 
and Review Services (SSARS) issued by the Accounting and Review Services Committee (ARSC) of the American Institute of 
Certified Public Accountants (AICPA). The 2011 edition of Compilations and Reviews is current through SSARS-20, Statement on 
Standards for Accounting and Review Services No. 20 (SSARS-20), Revised Applicability of Statements on Standards for Accounting and 
Review Services. 

The 2011 edition of Knowledge-Based Compilations and Reviews includes the very latest information and has been updated to take into 
account the latest literature, standards, and guidance applicable to compilation and review engagements. The 2011 tools include links 
to industry specific guidance that provides instant access to detailed analysis related to the steps and processes discussed in the 
workpapers. Also included is a revised financial statement disclosures checklist that provides a centralized resource of the required 
and recommended GAAP disclosures and key presentation items currently in effect, using the style referencing under the FASB 
Accounting Standards Codification™. The 2011 documents now include Accounting Research Material links to specific guidance 
that provides instant access to detailed analysis related to the steps and processes discussed in the workpapers. This is the second 
update to this Knowledge Coach title. If you are updating from the previous version of this title refer to the Knowledge Coach User 
Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

For more information on the Knowledge-Based Methodology and how it works within ProSystem fx® Knowledge Coach, 
refer to the Additional Information section in this bulletin. 

You must download and install Knowledge Coach 1.8 or higher before updating to the 2011 Compilation and Reviews content. The 
Knowledge Coach 1.8 will ensure that all the 2011 content is updated correctly. For more information on the Knowledge Coach 1.8, 
review the Release Notes and associated Knowledge-Base article at the following link: 

http://support.cch.com/updates/KnowledgeCoach/. If you have not installed Knowledge Coach 1.8, make sure to update all related 
and independent workpapers at the same time.  
 

You must be the current editor of all Knowledge Coach workpapers to update to the latest content during roll forward, and you 
must be the current editor upon opening the updated workpaper for the first time to ensure you see the updated workpaper. 

http://support.cch.com/updates/KnowledgeCoach/


 

  and  

 titles were changed from “Continuing Engagement” to “Review Performance Procedures” and 
“Compilation Performance Procedures,” respectively, to better reflect the purpose of the programs. 

  has been updated to provide a column for documenting the source of 
client information. 

  has been revised and reorganized. This workpaper now includes additional 
tailoring so that questions are shown or hidden based on CMP-100 tailoring questions for comparative financial statements 
and whether the engagement is continuing or noncontinuing. 

  has been updated to take into account independence 
considerations when the accountant is part of a network. 

  on S Corporations includes a new note on land held for investments; notes were 
renumbered. 
 

  has new tailoring for the Section IV table 
that shows or hides questions based on CMP-100 tailoring question for whether the engagement is new or reoccurring. 

 
 helps the accountant determine whether the engagement to review interim 

financial information should be conducted in accordance with SSARS or GAAS (for periods beginning on or before 
December 15, 2011). 

 

 helps the accountant determine whether the engagement to review interim 
financial information should be conducted in accordance with SSARS or GAAS (for periods beginning after December 15, 
2011). 

  is current through June 30, 2011, and includes the relevant 
citation from the Codification as of June 30, 2011, using the FASB classification system; public entities disclosure items 
have been deleted. 

 

 is designed as a guide for determining whether a review of interim financial 
information should be completed in accordance with SSARS or in accordance with AU 722 of Generally Accepted Auditing 
Standards (for periods beginning after December 15, 2011). 

  
provides a sample letter to predecessor accountant requesting information that will bear on whether to accept a new client 
or engagement. 

 
 provides a sample letter from client giving predecessor accountant permission to communicate with successor 

accountant. 

  through 
 provide sample compilation and review reports 

for periods ending on or after December 15, 2010 in accordance with the provisions of SSARS-19. 

  sample reports for periods ending before December 15, 2010 have been eliminated. 

 



 

  has been updated, where applicable, 
to provide additional guidance under SSARS-19 and to reflect organizational and instructional changes noted above.  

  has been revised and updated. 

 has been added as a 
reference document for the workpaper update information, along with list of related workpapers for the title. 

 

 has been added as a reference document. 

 

 AICPA Statement on Quality Control Standards No. 8 (SQCS-8), A Firm's System of Quality Control (Redrafted); and FASB 
Accounting Standards Codification (through June 30, 2011), including ASU No. 2011-02, Receivables (Topic 310) – A 
Creditor’s Determination of Whether a Restructuring Is a Troubled Debt Restructuring; ASU No. 2011-04, Fair Value Measurement 
(Topic 820) – Amendments to Achieve Common Fair Value Measurement and Disclosure Requirements in U.S. GAAP and IFRSs; and 
ASU No. 2011-05, Comprehensive Income (Topic 220) – Presentation of Comprehensive Income. 

 emphasizes using knowledge of the entity to perform 
compilation and review engagements by facilitating the flow of information so that the understanding obtained in each process affects the 
decisions made in the next. Although the accountant will likely perform most steps in this methodology sequentially, an engagement is not 
necessarily a linear process. Knowledge gained from pre-engagement procedures helps the accountant design and customize engagement 
procedures; evidence gained from procedures performed is evaluated and the appropriate accountant’s report is issued. 

The key components of the KBCR methodology include: 

 An Overview that guides accountants through the KBCR methodology. 

 Compilation Programs and Review Programs that take accountants through related steps and procedures designed for 
use in compilation and review engagements. 

 Practice Aids to help accountants complete steps or processes outlined in other related documents and provide example 
financial statement formats for different types of entities. 

 Reports that provide a variety of sample accountant’s reports on compiled or reviewed financial statements. 

 Correspondence documents that provide sample engagement letters and management representation letters to be used in 
many common situations. 

 Knowledge-Based Compilation and Review documents, integral to the overall engagement process, that contain steps 
and procedures required by SSARSs. 

functionality allows accountants to use the Knowledge-Based methodology more efficiently by 

eliminating the need for duplicate entry of the same information, tailoring documentation to each particular engagement. 

and are documents in Knowledge Coach that 
present engagement-level questions designed to aid in tailoring the engagement documentation to fit each client. Completing the 
questions helps the accountant avoid duplication and unnecessary workpapers. 

Before you begin your engagement, please review the guidance in and 

. These workpapers are intended to be your road map through the Knowledge-Based methodology. You 

should start your engagement with , , 

, and . 

http://www.accountingresearchmanager.com/wk/rm.nsf/0/37C16DD4A566F427862578690075CE69?OpenDocument#_blank
http://www.accountingresearchmanager.com/wk/rm.nsf/0/37C16DD4A566F427862578690075CE69?OpenDocument#_blank
http://www.accountingresearchmanager.com/wk/rm.nsf/0/DD023B66114B088C8625788F0049F1C4?OpenDocument#_blank
http://www.accountingresearchmanager.com/wk/rm.nsf/0/DD023B66114B088C8625788F0049F1C4?OpenDocument#_blank
http://www.accountingresearchmanager.com/wk/rm.nsf/0/28B67E4B19884D06862578B10056507D?OpenDocument#_blank


 

The Risk Assessment features have been disabled for the 2011 Knowledge-Based Compilations and Review Title for Knowledge 

Coach. Refer to  and  to accumulate and 

review significant issues and findings.  and 

 provide a guide for implementing the guidance related to the disclosure 
of certain significant risks and uncertainties. 

helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent 
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality 
helps you navigate quickly to the source of the information, aiding in the review of the engagement file. 

 help you keep track of unresolved issues like unanswered questions, missing workpapers, and more. Diagnostics now 
show when a form table has not been answered. 

If you subscribe to an ARM library that includes compilation and review 
content, you can link directly to source material from Resources within Knowledge Coach documents. These links have been 
updated to include references to the accounting standards under the FASB Accounting Standards CodificationTM. Also, if you 
subscribe to the Knowledge-Based Compilations and Reviews Guide on ARM, you can take advantage of brand new links to the guide 
material from within the Knowledge Coach documents. 

 is integrated into each Knowledge Coach template through the Tips view of each new task pane. 
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help accountants work more 
effectively and efficiently. We have also added the ability to navigate from Resources within a document or the tip pane directly to 
CCH’s Accounting Research Manager and industry guides by simply clicking on the Reference.

 If you are updating from the 2010 Knowledge-Based Compilations or 2010 Knowledge-Based Reviews, you must install Knowledge 
Coach 1.8 or higher to ensure that your content updates correctly. 

 Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated. 

 If your Current Editor Knowledge Coach MS Word workpapers become read-only or crash, please do the following: 
o Keep the binder with the affected workpapers open. 
o In the Tools drop-down menu from the Binder View screen, select Save Knowledge Coach Answers. 
o Contact Customer Service at 1-800-PFX-9998, option 4, option 1 if you have additional questions. 

 Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach 
workpapers can be shared across team members through check in, check out, workpaper assignment, synching to the 
central file room and through peer-to-peer synch in the same way that other Engagement workpapers are shared. 

 This title must be used with ProSystem fx Engagement version 6.8 and higher. If you are upgrading from ProSystem fx 
Engagement 6.0, 6.1, 6.1.2, or 6.5 please contact Technical Support at 1-800-PFX-9998, option 4, then option 1 for detailed 
instructions. 

 A minimum of 2GB of RAM is required for optimal performance when opening and navigating through ProSystem fx 
Knowledge Coach documents. 

 

The 2011 Knowledge-Based Compilations and Reviews title has been separated into two separate package files. Both of these 
packages only require one license to be assigned to the user in the Admin Module. Please see the section Installation Instructions 
below for more information. 

 2011 Knowledge-Based Compilations 

 2011 Knowledge-Based Reviews 
 
  



 

Download the 2011 Knowledge-Based Compilations and Reviews titles from the ProSystem fx Knowledge Coach Updates section of the 
ProSystem fx Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then 
select the Knowledge Coach Series and Download file link next to the 2011 Knowledge-Based Compilations and then the 
2011 Knowledge-Based Reviews title. On some occasions the content package file (.KCP) has downloaded with the extension 
changed to .ZIP. If this occurs, please change the extension of the downloaded file to KCP using all capital letters. 

: ProSystem fx Engagement version 6.8 or higher must be installed on the computer in order to install this Knowledge 
Coach title. Additional requirements include Microsoft Office 2007, Microsoft Office 2003 Primary Interop Assemblies (PIA) and 
Visual Studios 2005 Tools for Office Second Edition Runtime (VSTOR). 

The following 2011 Knowledge-Based Compilations and Reviews (12/5/11).KCP download is a proprietary file that must be 
installed from within Engagement. Save this KCP file to a location on your local drive, extract it, and follow the Installation 
Instructions included in the Release Bulletin.

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx 
Engagement. The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach program 
content files. Please refer to the ProSystem fx Engagement with Knowledge Coach Release Notes for any other system 
requirements. 

After downloading the 2011 Knowledge-Based Compilations and Reviews titles, do the following: 

1. Launch the ProSystem fx Engagement Workpaper Management application so that the Local File Room is 
displayed. 

2. Select Tools > Knowledge Coach Titles. The Knowledge Coach Titles window displays. 
3. Choose Add Title. 
4. Browse to the title package file (*.KCP) that you previously downloaded and extracted from the ProSystem fx 

Knowledge Coach Support Web site.  
5. Choose Open. The system will display a progress indicator while the title package is added. You will receive a 

message that the title has been successfully installed once the process is complete. 
 

Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease” 
previous versions of the title. 

To unrelease a title: 

1. Select a previous version of the Knowledge-Based Compilations and Reviews title 
2. Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the staff 

group property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.  
 

 You can determine this access in the ProSystem fx Engagement Administrator module by selecting a staff group 
and choosing File > Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option 

To release a title: 

1. Select one of the Knowledge Coach titles in the list that has been added but is not yet released.  
2. Choose Release Title. The current date and time will be displayed in the Date released column, and the status will 

change to “Released.”  
 

 You must add and assign a Knowledge Coach module as well as the Knowledge Tools title license in the  
ProSystem fx Engagement Administrator before using the workpapers. 

 Once the 2011 Knowledge-Based Compilations and Reviews title has been added and released, it will be 
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder 
that contains Knowledge Coach workpapers from this title. 



 

Permission key files may be downloaded from our Web site at http://tax.cchgroup.com or when adding or updating the new 
licenses within ProSystem fx Engagement with Knowledge Coach version 6.8 and higher. After updating the license file in the 
ProSystem fx Engagement Admin module, licenses need to be assigned to the staff who will use 2011 Knowledge-Based Compilations and 
Reviews. 

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.  

Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to 
http://tax.cchgroup.com/pfxsupport, clicking the Firm Administration link, and making the appropriate selection (SSO access is 
required), or by contacting Customer Service at 1-800-PFX-9998, option 4, then option 1. 

CCH’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting 
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written 
interpretive guidance. 

Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most 
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus 
guidance from financial reporting experts. 

Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts 
attend critical standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and 
deliberations of current financial reporting projects as soon as they occur. Plus, you’ll benefit from their easy-to-understand technical 
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective. 

Newly available is the Knowledge-Based Compilations and Reviews, a guide that helps you comply with the AICPA's standards and 
has incorporated the Knowledge-Based methodology. The primary objective of the guide is to provide accountants with an effective 
approach for conducting compilations and reviews. This publication supplements and complements the Knowledge-Based 
documents that are available in Knowledge Coach. 

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more 
about our content, our experts, and how you can request a free trial by visiting http://www.accountingresearchmanager.com. 
You can also access the Accounting Research Manager Web site by selecting the item in ProSystem fx Engagement from the 
Guidance tab on the Shortcuts bar in the Binder window.  

As indicated above, subscribers to an Accounting Research Manager library that includes source content can link directly to source 
material from references within Knowledge Coach workpapers. These links have been updated to reference the new Codification 
released by the FASB and available on ARM. The Codification on ARM is fully integrated with U.S. and international accounting 
standards, other non-authoritative materials and industry leading interpretive guidance.  



 

Figure 1 – New Knowledge Coach Workpaper 

 
To use your Knowledge Coach Workpaper Templates, open 
a binder in ProSystem fx Engagement, select the workpaper 
tab into which you would like to insert the workpaper, and 
select New Knowledge Coach Workpaper from the 
toolbar or File menu. The New Knowledge Coach Workpaper 
dialog appears (Figure 1). 

Select the new Knowledge Coach title with the content 
you would like to use. You can select only titles you have 
installed. The information displayed changes to reflect the 
workpaper organization available for the selected title. 
Select the Knowledge Coach Workpaper Templates to 
insert into your binder and click OK. The Selected 
Workpaper Properties dialog appears. Each workpaper name 
is automatically loaded into the Name field. Add a 
workpaper index in the Index field and make any Name 
modifications you desire. You can also modify the tab 
location or the roll forward settings for each workpaper. 
Then click OK. The integrated Knowledge Coach 
workpaper is now inserted into your engagement binder. 
For more information on how to use Knowledge Coach 
workpapers in your binder, see the Knowledge Coach User Guide.  

 

Download Description: 
2011 Knowledge-Based Compilations and Reviews 
(12/7/11) 

Version: Engagement v. 6.8 with Knowledge Coach or higher 

Release Date: December 2011 

File size: 14MB 

Approx. Download 
Time: 

45 minutes at 56 kbps 

License: Full Version 

Platforms: Windows XP/Vista 

Office: Microsoft Office 2007 required 

 

For a demo or to purchase additional titles as they become available 1-800-PFX-9998, option 1 
Technical Support 1-800-PFX-9998, option 4, then option 1 

The ProSystem fx Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by 
CCH, a Wolters Kluwer business. The contact information above can be used for customer service and support issues for this 
product. For information about other CCH products, please call 1-800-248-3248 or visit the online store at 
http://tax.cchgroup.com. 


